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Customer Support

Tech Support
Need tech support? Add “support@bettercellsnutrition.com” to your spreadsheet. When
sharing, add your request/bug in the notes section.

Help Desk
You can also start a conversation with us right in the Raw Fed and Nerdy group here.

Tutorial Videos
Check out the tutorial videos here. Includes videos for:

● Setup and authorization
● RFN Sheet basic use
● Google Sheets and Drive 101
● How to use the Add-on

3

mailto:support@bettercellsnutrition.com
https://www.facebook.com/groups/rawfedandnerdy/permalink/750013465687263/
https://rawfedandnerdy.com/formulation-sheet-help


Setup and Authorization
Once you purchase the spreadsheet, you will receive an email from Raw Fed and Nerdy
immediately. This email frequently goes to your spam or junk mail so make sure you
check there. If you did not receive this email, please email Jenny at
jenny@bettercellsnutrition.com.

The order email will include a link to a Google Group that contains the master copy of
the RFN Sheet.

Please note that the copy of the spreadsheet linked in the Google Group is the master
copy that is available to everyone who purchases the spreadsheet. It is view only and
you will not be able to edit it.

To get your own copy of the
spreadsheet:

1. Go to the post titled "RFN
Formulation Spreadsheet v4 -
Invitation to view" and click
"Open in Sheets."

2. This spreadsheet will be
“view only”. Create a copy of it
into your Google Drive in order
to edit it. (Top bar -> File ->
Make a copy)
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3. Once you have your own copy to edit, enter your RFN order number (make sure to
check your spam folder for your order email from RFN) in the first box, then click on the
green box and click “allow access.” You should now be authorized and ready to use your
spreadsheet!

IMPORTANT - You are only allowed to make 2 copies maximum of the RFN Sheet. It is
recommended to reserve your second copy for cases where you may need to start fresh
with your RFN Sheet.
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Downloading the RFN Add-on

To download the add-on, go to your spreadsheet.
1. Go to the top bar, and click on the “Extensions” menu.
2. Under Extensions, click on “Add-ons”, then click “Get add-ons”
3. In the marketplace, search for "raw fed and nerdy".
4. Install the add-on.
5. Once installed, go to Extensions -> Add-ons -> Manage add-ons. You should see the
RFN Add-on in your list of installed add-ons.
6. Click on the three dots on the upper right corner of the add-on.

7. Select “Use in this document.”

8. Refresh the spreadsheet.You should now be able to use the add-on!
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Create a Pet Profile
In order to formulate for a pet, you need to create and save a pet profile.

1. Go to the “Create a Pet Profile” tab.

2. Fill in the optional cells (more information below).

3. Once you are done filling in all the options, you need to save the pet profile. Copy the
entire purple column on the right.

4. Go to the “Saved Pet Profiles” tab.

5. On an empty column, paste values only. If you see #REF or other errors, delete the
column and try again, making sure to paste values only (right click to find more paste
options)

Create a Pet Profile Options

Pet Name - required: Your pet’s name

Pet is a - required: Your pet’s species

Age - required: Your pet’s age in years

Does this pet have black fur? - optional: Checking this box updates your pet’s
requirements to include additional tyrosine requirements needed to maintain pigment in
black fur.

Weight - required: Enter your pet’s weight. Select the unit for the pet’s weight in the
second drop down menu (unit).

Is this cat overweight?- optional: Check this box if the cat is overweight. This will affect
their energy and nutrient requirement calculations. This option only applies for cat
profiles.
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Base Requirements On - required: Choose the nutritional standard to formulate to. There
are three options, NRC, FEDIAF and AAFCO. More information about each of the three
standards here.

Energy Needs

Calculate Energy By - required: Please the option you will use to enter your pet’s caloric
intake.

Enter Pet's Energy Factor for Maintenance - required: Enter your pet’s energy factor to
estimate your pet’s daily caloric need. See table listed in the RFN Sheet for the typical
range of energy factors based on the standard and species. This option only applies if
calculating energy by “Estimated Energy Factor.”

Enter Pet’s Current Daily Caloric Intake - required: Enter your pet’s current daily caloric
intake. This option only applies if calculating energy by “Current Caloric Intake.”

Is this pet at an ideal weight? - required: Select Yes or No depending on whether your
pet is at their ideal weight. Only applies to adult animals.

What is the pet's ideal weight? - required: Enter your pet’s ideal weight. This can be
lower or higher than their current weight. This option only applies if you answered “Yes”
to the question “Is this pet at an ideal weight?”

Recommended Daily Caloric Intake (kcal) - automatic: This field automatically
calculates your pet’s recommended daily calorie goal, based on their species, weight,
current daily caloric intake or energy factor.

Use the recommended daily intake? - required: Select Yes or No to use the
automatically calculated daily energy goal, or to enter your own.

Set Daily Caloric Goal - required: Enter your pet’s daily calorie goal. This option only
applies if you answered “No” to “Use the recommended daily intake?”

Macronutrient Goals

Optional - Enter your pet’s macronutrient goals by caloric distribution. See the following
guides for help on setting macronutrient goals.
How to Set Macronutrient Goals
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How to Calculate Macronutrients from Food Labels
Fiber Guide

Bio-availability

Bio-availability of Cooked Starches and Bio-availability of Other Plants - required: If you
want to account for minerals from plant matter, you can use these settings to decrease
the values of minerals from plant sources.  More information on how to set these charts
here. These charts default at 100%.

Diet Restrictions and Other Notes

Optional - Type any other notes about the pet here to save it into the pet profile.
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Recipe Builder (Including Condensed Recipe Builder)
This is where you can build your pet’s recipe.

Adding a Pet

1. Under the “Pet Profile” or “Add a Pet” section, find your pet under the drop down
menu. If your pet is not available in the drop down menu, make sure you have saved the
pet profile into the “Saved Pet Profiles” section.

2. Select the number of days you want the recipe to be for under “Recipe For”.

Cross Check Requirements
This is a blue checkbox feature on the Recipe Builder and Condensed Recipe Builder. It
allows the user to double check the accuracy of their nutritional requirements.

All requirements (NRC, AAFCO, FEDIAF) are based on the pet profile's "energy factor" (or
"energy multiplier) and the pet's calorie goal. When formulating, it can be easy to
formulate a recipe that's lower or higher in calories than expected. In these cases,
checking the box to "cross check requirements" recalculates your requirements to be
accurate for the recipe's current calorie content and the respective energy factor.

Keep in mind that leaving this box checked does mean that requirements will
recalculate any time calories are removed or added from a recipe (in other words, any
time users add or remove ingredients from the recipe). This means requirements will
constantly change any time the recipe changes.

Adding Ingredients

1. Add ingredients by selecting them in the drop down menus. You can scroll through
the drop down menu to look at the available ingredients, or you can start typing the
name of the ingredient to find it faster.
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2. Add the quantity of the ingredient you want to add to the recipe.

3. Select the unit from the dropdown menu. For most ingredients, options will be grams
or ounces. For supplements (categorized as “supplement” in the Food Database), the
unit will be the serving size as entered into the Food Database.

4. Check the box to add the ingredient to your recipe. If you want to remove it, you can
delete the quantity or the ingredient name, or uncheck the box.

Nutrient Columns

Nutrient Requirements - “Required” Column
Your pet’s nutrient requirements will populate under the “required” column next to the
nutrient name. This requirement is set according to the standard you chose for the pet
and will differ between the three standards.

Note: If you have the Cross Check Requirements checkbox ticked, requirements will
change any time you change the recipe.

Nutrients in Recipe - “Total” Column
This column shows you the total amount of the nutrient included in the recipe thus far.

Nutrient Safe Upper Limits - “SUL” Column
This column shows you the value of the standard’s set SUL (safe upper limit). Once the
total amount of the nutrient in your recipe surpasses this value, your percentage cell will
turn red.

Percentage of Recommended Allowances - “% of Goal” Column
This column shows you the percentage of the nutrient content in your recipe, per your
pet’s required amount.

For example, 150% for Calcium would mean the recipe contains 1.5 times the amount of
calcium that is required for your pet.

The percentage cell will turn different colors based
on your recipe.
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White with black text: This means that there is no requirement for this nutrient.

Gray with black text: This means that you do not need to meet the required amount.
View the note for the nutrient in the spreadsheet for information why.

Blue with black text: This means that there is a requirement and the recipe does not
meet it.

Green with white text: This means that the recipe meets the requirement.

Green with yellow text - for minerals only: This means that the recipe meets the
requirement for this mineral, but the value is lower than the average for the minerals.

Green with red text - for minerals only: This means that the recipe meets the
requirement for this mineral, but the value is lower than the average for the minerals.
This is NOT the same as hitting SUL.

Red with white text: This means that the recipe surpasses the SUL.

NOTE: You cannot change the name of nutrients in the Recipe Builder or in the Food
Database.

Batch Ingredients List
You can use this section to multiply your recipe. Select the number to multiply by under
“Servings” and the units you would like it displayed in.

Nutrient Contributor List
You can use this section to see which ingredients contribute the most to least of a
particular nutrient.

Save Recipe as Ingredient
You can use this section to save your recipe as an ingredient into the Food Database.
You do not need to use this feature if you saved your recipe using the Add-on.
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Saving Recipes

Using the Add-on
1. Name the Recipe in the top left corner.
2. Go to the top bar, Extensions -> RFN -> Recipes -> Save

Manually (Without the Add-on) in Recipe Builder
1. Copy the first two rows of your ingredient section.
2. Go to the Recipe Database.
3.  In column C, paste transposed (right click->paste special->paste transposed).
4. Fill in the name of the recipe, the pet's name, the number of days the recipe is for.
Make sure these are the same for all the ingredients of that recipe.
5. Go back to the Recipe Builder. Copy the third row (units) in the ingredient section.
6. In the Recipe Database, in column G, paste transposed (right click->paste
special->paste transposed).
7. Use the “Save This Recipe as an Ingredient” section to save the recipe to the Food
Database.

Manually (Without the Add-on) in Condensed Recipe Builder
1. Copy the first two columns of your ingredient section.
2. Go to the Recipe Database.
3.  In column C, paste values only. (right click -> paste special -> values only)
4. Fill in the name of the recipe, the pet's name, the number of days the recipe is for.
Make sure these are the same for all the ingredients of that recipe.
5. Go back to the Condensed Recipe Builder. Copy the third column (units) in the
ingredient section.
6. In the Recipe Database, in column G, paste values only (right click -> paste special ->
values only).
7. Use the “Save This Recipe as an Ingredient” section to save the recipe to the Food
Database.
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Loading Recipes into Recipe Builder

Using the Add-on
1. Go to the top bar Extensions -> RFN -> Recipes -> Edit
2. Select the options in the drop down menus:

Populate only: Adds the recipe to the current recipe builder without removing the current
ingredients and quantities.

Manually (Without the Add-on) in Recipe Builder
1. Go to the Recipe Database. Copy the "ingredient" and "quantity" columns of the recipe
you want to edit.
2. Clear the Recipe Builder of all previous ingredients and quantities, if needed.
3. In the first ingredient column, on the ingredient cell, paste, transposed. (right click ->
paste special -> transposed)
4. Repeat for the units.

Manually (Without the Add-on) in Condensed Recipe Builder
1. Go to the Recipe Database. Copy the "ingredient" and "quantity" columns of the recipe
you want to edit.
2. Clear the Recipe Builder of all previous ingredients and quantities, if needed.
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3. In the first ingredient column, on the ingredient cell, paste, values only. (right click ->
paste special -> values only)
4. Repeat for the units.

Add More Ingredient Columns - Recipe Builder
1. Add as many extra columns you would like by right clicking on the column letter at
the top -> Insert 1 left/right
2. Copy the entire column of another, previously existing ingredient. If you skip this step,
the new ingredient column will not calculate nutrient values for that ingredient.
3. Paste into all the newly created columns.

Clearing Recipe Builders with Add-on
Go to the top bar Extensions -> RFN -> Clear

This clears the recipe builder of all ingredients, quantities, units and checkboxes, as well
as the recipe name and pet profile.
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Recipe Report

Select a recipe from the drop down menu. The recipe has to be saved into the Recipe
Database in order for it to show up here.

If you edit your recipe, make sure to save in order to see the changes reflected in the
Recipe Report.

Ingredient List - “Change Quantity”
If you want a batch list of ingredients for your recipe, you can enter a number here to
multiply your ingredients.

For example, if your recipe is for 1 day and you enter “30”, you will see the list of
ingredients for 30 days. If your recipe is for 7 days and you enter “4”, you will see the list
of ingredients for 28 days.

Creating a PDF or Printing
1. Hide any empty ingredient rows you didn't use. You can do this by highlighting the
rows, right click on the row numbers on the left -> hide. You can also hide the
instructions column so it doesn't show up on your printing.

2. File -> print to go to the print settings.

3. Print settings:
- Current sheet
- Portrait
- Fit to width
- Optional: Set custom page breaks

4. Print to your preferred printer or print to PDF to create a PDF.
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Food Database
This is the database of all the ingredients you can add to your recipes.

How to Enter New Foods
1. Go to an empty column or create an empty column.
2. At the top, row "Item Name", type in the item name.
3. For row "type", select the type of item it is.

Animal - ingredients with full bio-availability, such as most animal derived ingredients
Cooked Starches - ingredients with lowered bio-availability, such as cooked starchy
plants
Other plants - ingredients with the lowest assumed bio-availability
Supplement - ingredients measured units other than grams.
Recipe - to be used for recipes saved as ingredients

4. For serving size, enter the quantity in grams, the nutritional analysis is for. If the item
is not measured by grams, enter the full quantity and unit of the serving size in the cell.

For example, ground beef’s analysis is per 100 grams. Serving size is “100”. For a
calcium tablet, analysis is per 2 tablets. Serving size is “2 tablets”.

5. Fill in the nutritional analysis of the item. Make sure to double check conversions to
the appropriate unit.

How to Enter New Foods with the Add-on
1. Go to FoodData Central to search for and find the ingredient you want to import. We
recommend you use "SR Legacy" type foods.

2. Find the item's 6 digit  FDC ID.

3. At the top bar, go to RFN -> USDA/FDC -> Get Report.

4. Go to the last filled column in the Food Database.
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5. Fill in the item name and type.

Animal - ingredients with full bio-availability, such as most animal derived ingredients
Cooked Starches - ingredients with lowered bio-availability, such as cooked starchy
plants
Other plants - ingredients with the lowest assumed bio-availability
Supplement - ingredients measured units other than grams.
Recipe - to be used for recipes saved as ingredients

Entering Raw Meaty Bones, Premades and Fatty Acids
For more information on how to enter bone-in values, premades and unspecified fatty
acids, see the full guide here.

18

https://bettercellsnutrition.com/adding-premades-rmbs/


RFN Formulation Sheet and Add-on Terms of Service
The term “Product” includes all copies of documents, digital data, software, and other
materials, physical and digital, both distinct parts and composite packages, which
comprise the Raw Fed and Nerdy Formulation Sheet, Raw Fed and Nerdy Pack
Formulation Sheet, Raw Fed and Nerdy Puppy Formulation Sheet, and Raw Fed and
Nerdy Puppy Formulation Sheet Professional Report.

The term “Vendor” refers to One Ryoof LLC DBA Better Cells, hereinafter referred to as
Better Cells. The term “User” refers to the person or entity that is agreeing to be bound
by this Agreement, and employees and third party contracts that provided services to
the User. The User shall be liable for any failure by such employees and third party
contractors to comply with the terms of this Agreement.

User desires to purchase this product under the terms and conditions stated below.

License
1. Under this Agreement, the Vendor grants the User non-exclusive and

non-transferable access to use the Product.
2. The Vendor warrants and represents that it is the copyright holder of the Product.

The Vendor warrants and represents that by granting a license to use this
Product is not in violation of any other agreement, copyright or applicable
statute.

Intellectual Property
1. Title, copyright, intellectual property rights and distribution rights of the Product
remain exclusively with the Vendor. Intellectual property rights include the look and feel
of the Product. This Agreement constitutes a license for use only and is not in any way a
transfer of ownership rights of the Product.

2. User shall not modify, distribute or sell the Product, or use or modify the Product code
or application of formulas, to do so. The Product may not be modified,
reverse-engineered or de-compiled in any manner through current or future available
technologies.

3. The User retains the right to distribute a byproduct of the Product, hereby referred to
as a “Report”. The definition of a "Report" refers to a digital or physical document or
image that portrays the result of using the Product, but does not contain the
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functionality of the Product itself, and in accordance to the restrictions of modification,
distribution, and sale of the Product or Product code as noted previously in the
Agreement. Each copy of each Report, whether distributed commercially or
non-commercially, is to include the following notification visibly and prominently: “The
Raw Fed and Nerdy Formulation Spreadsheet © Better Cells was used in the creation of
this work (https://rawfedandnerdy.com/formulate).”

4. The User retains the right to create and authorize for use two copies of the Product,
across any devices, for each purchase. Any additional copies must be agreed to, in
writing, by the Vendor. Violation of this agreement may result in revocation of access
from Product without guarantee of reinstating access.

Disclaimer of Warranty
1. The Product is provided by the Vendor and accepted by the User “as is.” Liability of
the Vendor will be limited to a maximum of the original purchase price of the Product.
The Vendor will not be liable for any general, special, incidental or consequential
damages due to the User’s use of the Product. When using the Product, User assumes
all risk associated with verifying values contained in the Product.

2. The Vendor makes no warranty expressed or implied regarding the fitness of the
Product for a particular purpose or that the Product will be suitable or appropriate for
the specific requirements of the User.

3. The Vendor does not warrant that the use of the Product will be uninterrupted or
error-free. The User accepts the Product in general is prone to bugs and flaws within an
acceptable level as determined in the industry.

RFN Formulation Sheet Add-on Agreement

The term “Add-on” includes all copies of documents, digital data, software, and other
materials, physical and digital, both distinct parts and composite packages, which
comprise the RFN Formulation Sheet Add-on.

The term “Owner” refers to Anh Pham, creator of the Add-on. The term “User” refers to
the person or entity that is agreeing to be bound by this Agreement, and employees and
third party contracts that provided services to the User. The User shall be liable for any
failure by such employees and third party contractors to comply with the terms of this
Agreement.
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User desires to use this Add-on under the terms and conditions stated below.

License
1. Under this Agreement, the Owner grants the User non-exclusive and

non-transferable access to use the Add-on.
2. The Owner warrants and represents that it is the copyright holder of the Add-on.

The Owner warrants and represents that by granting a license to use this Add-on
is not in violation of any other agreement, copyright or applicable statute.

Intellectual Property
1. Title, copyright, intellectual property rights and distribution rights of the Add-on
remain exclusively with the Owner. Intellectual property rights include the look and feel
of the Add-on. This Agreement constitutes a license for use only and is not in any way a
transfer of ownership rights of the Add-on.

2. User shall not modify, distribute or sell the Add-on, or use or modify the Add-on code
or application to do so. The Add-on may not be modified, reverse-engineered or
de-compiled in any manner through current or future available technologies.

Disclaimer of Warranty
1. The Add-on is provided by the Owner and accepted by the User “as is.” The Owner will
not be liable for any general, special, incidental or consequential damages due to the
User’s use of the Add-on. When using the Add-on, User assumes all risk associated with
verifying values contained in the Add-on.

2. The Owner does not warrant that the use of the Add-on will be uninterrupted or
error-free. The User accepts the Add-on in general is prone to bugs and flaws within an
acceptable level as determined in the industry.

Remedies
User agrees that should a court of competent jurisdiction find that User has violated or
breached any part of this Agreement, then it shall be understood and agreed that
Vendor shall be entitled to injunctive relief against User with respect to any breach of
said Agreement and, in addition, Vendor shall be entitled to any and all other applicable
remedies at law and in equity which are appropriate and necessary to prevent User from
further breaches of said Agreement, or to compensate or make Vendor whole with
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respect to any damages experienced by it as a result of the action of User, including a
reasonable attorney's fee for the enforcement of this Agreement.

All terms, conditions and obligations of this Agreement will be deemed acceptable by
the User upon signing this Agreement. The term of this Agreement will begin when User
agrees and is perpetual. This Agreement will be terminated and the license forfeited
where the User had failed to comply with any of the terms of this Agreement or is in
breach of this Agreement. Upon termination of this Agreement for any reason, the User
will promptly destroy their Product and any materials provided with the Product by the
Vendor. Failure to comply with any of the terms will be considered a material breach of
this Agreement.
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